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SCMS Certification ~

DUNS Filter

Supplier Records

Supplier: 788077634 - GM ADVANCED ENGINEERING STAFF
MILFORD PROVING GROUNDS BLDGS6
MILFORD - M - 48380 - US

Ultimate Duns: 005356613

Sourceability Report for DUNS Sourceability Report for Ultimate DUNS impact Delail Report
+ Add Record Include Expired Records Include Audit Records
Status Recoed Type Tite Effective Date Forecast Date Expire Date

AR AR R ESCER (QPR) HIHE4I(E R, W7E GM SupplyPower FHJ Document Library H £ [, 45:
GM 1927 17. BRI ES0CER (QPR) Al SQEA 3R, CG 4338 GM 1927 03 fLN 5 i s SOR CELR )
2, BEINZAEN SupplyPower.

Supplier Document Library

Select Function(s) -
2022 GM Quality Performance Save Search Clear Filters
Filters > Title Type = Size Qwner Contact Information = Revision =  LastUpdate = Preview

2022 GM QPR and SQEA requirements
2022 GM QPR and SQEA requirements Quality Performance

qt y PDF 23268 Supplier Quality )
Requirements Supplier_Quality@gm.com

Supplier Quality GLOBAL Supporting Document Guidelines GM 1927

Purpose >

1 2022-06-29 Preview

Supplier Document Library

Select Function(s) -
CG4338 Save Search Clear Filters
Filters > Title Type = Size Qwner Contact Information = Revision =  LastUpdate =

CG4338 GM 1927 03 Supplier Quality Statement Of Requirements
CG4338 GM 1927 03 Supplier Quality Statement Of Requirements DOCX 276.0 kB Arthany Ghrisopoulis 15 2022-10-14

Purpose ¥ anthony.chrisopoulos@gm.com
Supp[ier Qua\rty GLOBAL GM 1927 CGXXXX GM 1927 03a
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gm Impact Detail Report
Mfg DUNS: 123456789 - Anywhere USA  Ult DUNS: 987654321
Mfg DUNS Location: 123 MAIN ST

KEOKUK, IA - 526322259 - US - GMNA

|Eﬁeuive Date Expiration Date

|IATF 16949: CERT 08/19/2021  08/18/2024
PSA:
SQEA: 2016,2017
NBH: A

Issue Date | SPPS/SCMS# Status Direct Impact 5 c::;::gact Type Mast:;ir:cess Primary N/C Secondary N/C
06/11/2022 Closed Quality - CCA 5 CCA - Shipment Quality Packaging Parts not packaged to specification for service
07112022 " Closed GSCRating-CCA 5 CCA- Supply Chain Shipping Documentation / Paperwork Discrepancies
02112022 " Closed Sourceability Level 10.25 Quality
06/1172022 _ Closed Sourceability Level 1 Quality
11/1612022 '_ Analyzing Sourceability Level 05 Quality
7

PEARSEMIR A5 e« ELEEREA " TR A H A4 30 ) B, ASiB R (AR5 . CCAL GSC-mimss) , #iE %
Hil e M IER TR, R IR

SPPS/SCMS#—%I1%% SPPS L4 5. 1EVER, SCMS itV Fiicsk (IfdE SPPSic%) Hieft T NBH/HRS H /T
RIS S

IRSFEBH T SPPS M RRAPIRAS, ZIRESHIE XS N GM 1927-17 SQ T FEFVHETER .

GM 1927-17 SQ i FEFIPEAEFEFF i LU R T 200 7™ 81 PP AE T B

Bl ® 6 NH WITH RER = I e . fER P RIS s Kb, BESEER 2 MNANRED
SEEE . BEAR, NUEATLR B A% 53 SR FH B DT 0 S AR OT B I AR e
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Subject: General Motors SPPS 000 — Entry into Controlled Shipping Level 2

TO LIST: test@test.com;test@gm.com
CC LIST: test2@gm.com

Date: 31-May-2019 3:28 PM ET

Supplier Name

Title

000000000 —Supplier Name
Street Address

City, State, Country Zip code

Controlled Shipping is part of General Motors Supplier Quality Processes and Measurements Procedure and is part of the Supplier Quality
Improvement Process. General Motors has determined that current controls by your organization are not sufficient to insulate GMPT-WARREN
TRANSMISSION from the receipt of nonconforming parts/material produced by your facility. This letter is formal notification and confirms
discussions held with Supplier Name that your facility has been placed in Controlled Shipping Level 2 for the following nonconformances:

Part Number Part Name SPPS # Nonconformance

00000000 Part Name 000 Nonconformance description

Links to SPPS Application:
GM/JV Users click here
Supplier Users click here

The procedures you have enacted to date have been insufficient in stopping the flow of nonconforming material to our plants. Therefore, you must
immediately:

1. Implement and pay the costs of a GM-defined containment activity over and above your current process controls and containment
activity. The GM-defined containment activity is in addition to the current controls and containment activity.

2. Clearly identify the qualified shipments. Clearly document and communicate post Corrective Action Break-Points to the Controlled
Shipping Provider.

3. Identify the root cause of the nonconformance(s).

4. Define and implement irreversible corrective action for the root cause(s) of the problem(s). This will normally include revised FMEAs,
process flow diagrams, and process control plans.

5. Validate effectiveness of the corrective action. Outline your plan for reviewing your controlled shipping data.

6. Track and report your progress by using a GM-approved report format. You must submit regular reports as specified by the GM
representative monitoring this activity.

7. Meet the defined exit criteria. The parts will remain in controlled shipping until irreversible corrective actions are implemented and
confirmed. Exit criteria will be established that verify the identification of the true root cause, and verify that appropriate corrective
action is implemented, properly documented, and effective.

8. Notify your IATF 16949 registrar of the CS2 status. You are to notify your certification registrar, in writing, within five (5) working days
when a customer places you in Controlled Shipping Level 2.

Note: Failure to comply with this process, or the inability to implement a successful action plan or containment activity, will result in the
implementation of new business hold. Reference the GM Supplier Quality Processes and Measurements Procedure at GM SupplyPower for
additional details concerning Controlled Shipping.

If you have any questions, contact GM Person Name, Title phone, email, who will be monitoring and defining your controlled shipping activities.

Sincerely, GM Person Name
Title
Department

(S

54 /18 71 2025 % 10 H
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#ili&i DUNS
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Impact Detail Report
Mfg DUNS Location: 123456789 - TESTING - CITY, STATE, REGION

e — P ——
[ Severity Scorellmpacl) . ] Primary NIC | Secondary N/C Major Disruption Customer Impact |
N—____” CCRA Packaging Parts not packaged to speahcation lor service:
2 COA - Supply Ghain Shipping Electronic Communication Discrepancies
05 Quakty Single Occurrence Par instatied in Vehicle/Eng or Tra
05 Cuality Single Occurrence Pan instabied in Vehicle/Eng of Tra
2 Quality Repeat Occurrence Part instatied in Vietacla/Eng of Tra
05 Chuality Single Occurrance Par instaied in Velscle'Eng or Tra
05 Cualty Repeat Oceurrence Incoming part. Not instaliad in Sub-
2 Chuality Repeat Occurrence Partinstalied in Vehlicle/Eng of Tra
0.25 Cuahty Single Occurrence Part instalied in Sub-assembly or \

P EE FE AR 0] JE B PV ZE RS, VE L GM 1927 17 SQ AR .
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Impact Detail Report

Mfg DUNS Location: 123456789 - TESTING - CITY, STATE, REGION

Customer Impact | Value Stream Impact Location
Level G.2: Critical failure Yard hold
Level F: Repeat of Level B,.D or E Parts sorting / rework (not yet assembled)
Single Occurrence Part installed in Sub-assembly or Vehicle/Eng or Trans. Sub-assembly or Vehicle/Eng or Trans repaired before
Repeat Occurrence Part installed in Sub-assembly or Vehicle/Eng or Trans. Sub-assembly or Vehicle/Eng or Trans repaired before
Multiple Occurrence Part installed in Sub-assembly or Vehicle/Eng or Trans. Sub-assembly or Vehicle/Eng or Trans repaired before

AT R AR R

Impact Detail Report

Mfg DUNS Location: 123456789 - TESTING - CITY, STATE, REGION

Issue Date SPPSJ‘SCMS#| Status | Direct Impact Sev‘enryﬁwpe | ?(er Primary NIC | Secondary N/C < Major Disruption >
Scorefimpac cess

0e222020 32894 Izsued GSC Aating-CCa 2 CC4 - Supply Chain

0702022 313960 Expired Sourceabilitu Level 15 Field Action
Field Action

0BNa2022 318522 Expired Sourceability Level 16 Field Action
Field Action

nahg2022 2e0? Izzued Launch Performance 1 DVPY-High Risk

09212020 3219m Closed Sourceability Level & Cuaality Yard hold, resulling in anincrease in the custorner's ward and or the custorner's shipping
ward Float by 40 praducts or mare [WehiclefPowertrainComponents) for a single issue,

2022 326849 Flanning  Sourceability Level 0.5 Cluality

07282022 6250 Flanning  Cuality - CCA & CCA - Part Quality Ouality Azzembly Discrepancies

556 /18 T 2025 4 10 A
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SCMS Certification -

DUNS Filter

AR AR

Supplier Records

upplier: 000148528 - DIRECTED BUY TRACKING RECORD - WARREN - M| - US

Sourceability Report for DUNS Sourceability Repaort for Ultimate DUNS

TR IR S 41
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P =y
=]

Impact Detaif Report

Impact Detail Report
Mfg DUNS: 123456780 - Anywhere USA  Ult DUNS: 987654321

Mifg DUNS Location: 123 MAIN ST

KEOKUK, 1A - 526322259 - US - GMNA

IATF 16949: CERT

PSA:
SQEA: 2016,2017
NBH: A4

Run Date: Nov 29, 2022 7.20.21 AW

lssueDate | spps/scms# | status Directimpact | ¢ cj?ev:;ga o Type Ma"f'ra'::r’e“l Primary NIC | Secondary NIC | Dimm:on | Customer impact Value Stream Impact Location | Pg;i:;” Phase
12022 Ciosed ualfy —CCA s CCA.- Shipment Qualky Packagig _ Parls not packaged o specification for service o
0711112022 Closed GSCRating-CCA 5 CCA - Supply Chain Shipping Documentation / Paperwork Discrepancies NO
021112022 Closed Sourceabilty Level 0.25 Qualty Single Occurrence Incoming part. Not installed in Sub-assembly or Vehicle/Eng or Tran NO Production
v irz022 Closed Sourceabily Level 1 Quaity Muliple Occurrence  Part installed in Sub-assembly or Vehicle/Eng or Trans. Sub-asser NG Froduction
111602022 | Analyzing Level 0.5 Quality Single Occurrence. Part installed in Wehicle/Eng or Trans. Vehicle/Eng or Trans. enterec NO Production

SCMS Certification ~

DUNS Filter

Supplier Records

Supplier: 000148528 - DIRECTED BUY TRACKING RECORD - WARREN - M| - US
Seurceability Report for DUNS

! Include Audit Records

+ Add Record Include Expired Records

Status Record Type Title Effective Date
@3 Eﬁ d a ACTION New Business Hold 09-Aug-2019
gEH Surveys
Status Survey Title Last Modified
-
] »
» ACTION Field Action 13-May-2019

¥7/18

Scurceability Report for Ultimate DUNS

Forecast Date

Attachments
Date Added

09-Aug-2019

NBH £
MER

Impact Detail Re|

Eupire Date
V4 4 v x
Document Name
Directed-Buy_NBH_GM1927-71.xis x =
>
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1) #EAN GM SPPS R4t

GENERAL MOTORS

SUPPLYPOWER © Help ~ & _° Sign Out Search Q

HOME CONNECT PARTNER COLLABORATE COMPLY OTHER

Administration

Edit My Profile

My Administrators

General Motors - Applications

all fiters
Show results for
® any filter

Filter by: | Functional Area ~ | [Cuaity =N -]
Scarch
Access Icon Name Summary Functional Area Reguest Favorite
; Giobal Analysis Reporting Tool 2.0 - GART 2.0 » Detail Quatity ~
Gilobal Quality Tracking Systermn Release 6 (GQTS) » Detail CQuality
SPPS F{—);H %n GME Lead Connect » Detail Quality
A AARES e p— — =
Problem Resolution Tracking System (PRTS+) » Detail Quality 7
SCMS-viewer Oniy ~Grant only ONE SCMS package per user = » Detail Quality =g
Si (Service Information) » Detail Quality 7
SPPS Site Codes and View » Detail Quality =g
Supplier Quality Management System (SQMS_SUPPLIER) » Detail Quality >

SPPS mquiw @ My fssues | YR Clear Fill

= sPPS Inquiry
Add SPPS R Status T SPPS No T lssue Date | . Type Y Part Numbar ¥ Part Dasaiption T Suppliar DUNS T Suppsier Nama T Cuslomer DUNS L
Link to GM 1927 17 v oec20is 5 Y W v
GM Practical Pr + = issued Cualty ’
Solving Form
+ = sues Quaity
+ = tssued Quaity
+ = tssued Couaiity.
+ = 8- tsend Quaity
+ = e Qualfly
+ |5 e Quality
+ = isswed Qualty
+ = lssued Supply Ghain N
< >
Mo . 2 3|4 » w  [20 W] itemsperpage 1-20 of 11678 flems
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2) fE SPPSNo. % L%\ SPPS 45 .

GM SPPS - Supplier Practical Problem Selving

—— Sesman Trmecut

i ® My lssues | YR Clear Fillers
SPPS Inquiry ad
= sPPS Inquiry
Add SPPS Record Status T SPPSNo i Type T Part Numiber ¥ Part Dascription T Supplier BUNS T Suppser Nama T Customer DUNS if
Link to GM 1927 17 g Y ¥ v
Prz al Problem + = tssued Quality rd
olving Form
+ = lssued Quaity
+ = ssued Quality
+ = lssued Dualty
+ = 81 -issune Qualny
+ = e Qualty
+ = tssued Gualty
+ = issued Quatty
+ = nswes Suppty Chiin 5
< >
o4 n 2 1 i | M 20 ~|  tems per page 1-20 of 11878 flams.

Lidia Natanail &

Seasion Timeout 2945

H @ My Issue: )% Clear Filters
SPPS Inquiry bl | R b ralion
i= SPPS Inquiry
Add SPPS Record Status Y SPPS No issue Date | Type v Part Number Y Part Description Y Suppher DUNS 2 Suppher Name ) Customer DUNS Y
Link to GM 1927 17 v W o3pec2018 B Y W v
GM Practical Problem 4+ = Closed Quaky

Solving Form

4) iy “ S fE, kR CSPPS ERIELIE R
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= SPPS Inquiry

Add SPPS

GM Practical Problem

Solving Form

5) Bk SPPSiCRIEANME R . A AL, fE B TP, POF #&FTEl.

SPPS Inquiry

Add SPPS Record

Link to GM 1927 17

GM Practical Problem
Solving Form

BHREIL D FEFRR

SPPS Inquiry

Status T SPPS Mo Hiue Date | Type i Pait Number T Pait Descriplion

v T ovoec20s ] T O v
ws Quaity
& Edit SPPS

{)  Coatainment Actions

B Detai Analysis

W&, Supplier iImprovement ACInAles
$  Cost Recovery Forecast

I anachments

B o

[ sPPs Recom Detail

M sPPs - Supplier Practical Problem Solving

SPPS Record Detail

SPPS Record Detail Report generated on 17-Jun-2019 2:.09 PM ET

Issue

SPPS Number

SPPS Type

SPPS Status

SPPS Issue Date

Date Closed

Supplier

Part Number

Problem Description and Method of Validation
Person Contacted at Supplier
Manufacture Date(s) of Defect Parts

Supplier Parts and/or Process are Out of Spec AND it was
not the fault of Ct 'S p or tooling?

Date converted from Supplier Alert (if applicable)
Potential Safety Concern

Customer Issue Owner

Management Confirmation

DUNS-Owning SQE

Supplies Name

@ My lssues || W% Clear Fill

~ canion Tt 7830

e BIEEAVRE SQE SRR Z MM IEREE TR, SRRSO 3 HEE =, INENEIE
i B A IR BEAT I, R IANS SR 15 U [ R T

SEREIY) SPPS RN E s

TSR T SPPS LR TR B ) F B SR e BAIR, IR R @ IR v

WG SQE B Bl R Bon 9 BUbR IR, IFARiEy “ 2BiE” .

XAKER 71— S Be O 7 iR, DABIER 0 BRI R RS S i R
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SPPS Record Detail Report generated on 12-Aug-2019 §:42 AM ET

Insue

SPPS Number

SPPS Type:

EPPS Status

SPPS Issue Date

Date Closed:

Supplier

Par Number:

Problem Descriztion and Method of Valdation

Person Contacied at Supplier:
Manufacture Date{s) of Defect Farts:

Supplier Parts and/or Process are Out of Spec AND 2 was not
the fault of Cusl '8 bicabl 55 or tookng?

Date converted from Suppller Alert (if appicable)
Potential Safety Concern:

Customer Issue Owner

Manager Approver for Customer lssus Owner
Management Confirmation

DUNS-Owning SQE

11/18 7L

11507

Cuaity

Closed

13.Jun-2019 10:18 AM ET

25-Jul-2018 11:31 AM ET

-———  —
I RADIATOR ASM-ENG COOL FAN MOL

PROGRAM E2UL

ISSUE DESCRIPTION: External threads on Schrader valve. where high pressure sensor mounts, are sifipped and the sensor was not fully instaded

PART DISPOSITION: The suppler has 24hrs 10 request the retum of suspect matenal for analysis and provida & FedEx shippng account number and
shipping drechons. After that tme suspect matenal may be scrapped by Fairfax

CONTAINMENT: Immediale containment is required with appicable breakpaints.  Fisase reply 1o the Containing section of SPPS as requines in
GM1827-14

PART IDENTIFICATION. Igéntty in SPPS response how indrndual pans will be marked for cendfication (dentify all certfied containers wih @ green
sticker cn the parts label with the indials of the perscn cerifying the material, along with the date ¢ was cerufied To NOT cover up any miormaton on
the label. GM Fairfax also requires an 8.5x11 inch paper on 2 sides of the contamer that says 100% certfied for (reason for cenification) . along with
the contact name & phone number, [f there & more than 1 centification active. then that 1 page needs 1o list every issue they ane cerdified for This
labeling mus! continue for 30 days from the stan of certification

CORRECTIVE ACTION DOCUMENTATICN Complete problem sohing documentation, FFMEA, process control plan. and decumentaticn/evidence of
controls used 10 avoid repetdion for this issue need to be anached in the SPPS system

TIMING: Fallure to meet the required submissicn deadine may resull in a Customer Satisfaction SPPS. | your analys's requires mere than 15
WOrKiNg days. you must request an exlenion Extension requests must deta why more than 15 days are requed and mciude an expected
completion dale. E-mai exdenson raquests to the ssuer within 15 woriong days from the date of issuance and note the exdension request in Ine
SPPS Planning secton data helds

Mot Listed
Unknown
YES

NO

S )

L )

Santosh C Sequevs () ¢ - .- 2010 528 PMET
£u ALEERTO sauceEDO sancHEL (D

2025 % 10 H
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Metrics Data

Phase Pradustion

Gustomas Quality Impact: Direct Run Rate

Customes Impac! Single Qccurrence

Furthes! Location in the Value Stream the Nen-Confarmance Part instaked in Vehicle/Eng or Trans. Vehide/Eng or Trans entered a5 Direct Run/|PPM.As a rasult Vohicla'Eng of Trane ishwas in Mot
has Reached:

Lasi Updstad Glenn D Goffin, EG, - .J.n-2015 1018 AM ET

Containment al Supplier Location

|ssue Cwner at Suppier Location: ey ]

|s Containmant Required &t this location? YEE

Can you meet Dally Requirements? YES

Descrise Containment Actions Taken or Reasan for Mo Cuality Alert was ssued and posted in shop floor. Team was mformed aboul the finding

Conainment Action Sensor comectly installed i valve condition has been audited. Parts has been cerified identified with matenal cedification sheet

LE237T003 192 =0K, 0=NO OK
LDS67003 688 = OF, 0= NQ OF
LOSET008 350 = OK. 0= NCG OK
LEZ37003 468 = 0K, 0= NO OK
MD214002 126 = OK, 0= NO OF

identification of Certfied Maienal: Sansor camectly installed in valve ls markad with blue dot

Lasi Updaied Jorge Vilanueva, (N .20 15 1124 AM ET
Assessmeni Slalus/Reason:

Assessment Datails:

Supplier Response Daads:

Containment at Issuing Custemer Location
Issuing Customer Location: 007145859 - 18044 - NAD FAIRFAX

Conforming Maierial Date {from Containment &1 Supplier
Location)

Conformeng Matecial ASN (from Containment at Supplier
Location)

12 /18 2025 4F 10 A
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Suppiler lssue Owner &l Customer Location
Is Containment Required al this lncation?

Confarming Material Diate (from Containment a1 Customer
Location)

ESEP Pravider

Describe Containment Actions Taken or Reason for No
Cantainment Action:

|denification of Certified Matsrial:
Last Updated

Assessment Status/Reason
Assessment Delails:

Supplier Responss Detlalls;

Agsessment Last Updated

P ially d Customer Locations

Customer Locabon Potentially Affecied

Cenforming Matesial Date (from Containment al Supplier
Location)

Conforming Matssial ASN (from Containment at Supplier
Location):

Supplier [ssue Ownet al Customer Location
18 Containment Required at this location?

Conforming Material Date (frem Containment st Customer
Lecaticn)

ESEF Provider

Descrite Comainment Actions Taken or Reasan far No
Confalnment Action

Identification of Cerified Material:
Last Updated:

Asssssment StatusReasen
Assessment Cetails:

Supplier Response Details:
Assessment Last Updated:

Datail Analysis
Roct Cause:

Lasi Updated:

Assassment Stetus/Reason
Asszsament Detfails:

Supplier Response Details:
Assessment Last Updated:

3P Suppller Improvement Activities
Improvemeant Actrvity Type

BIQS EBements / MMOG-LE Subchapters:
Targel Completion Date

Expected Conforming Matenal Date:
Aciual Completion Date:

13 /18 7

Jorge Villanueva,
NO
24-Jun-2018

Problem not noticeabie uniil its in produstien. Condion can nat ba surely checked without takeng the sensar off

sorge Vitanuev, (R 1¢-.-2015 11,32 AM ET

Sensor was [nstalled meorectly on condenser vahe due 1o Tomue controlier was not in fix position (leose condition) and seating fixture did not parmd
100% verlical position, providing chances fo piace sensor in a tiled posiion

Jarge vilarueys, (N :-un-2(0 15 404 FM ET

Pradict
PFMEA
28 Jun-2013
12-Jul-2018
12-Jis-2015

2025 £ 10 A
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First Conforming Matenal ASH:

Supplier Improvement Activity | Reasan for No Bupplier
Improvemant Aciny

Supplier Verification Steps Taken

Approved
‘arifisd

Assessmant Slalus/Reason:
Assessment Delails.

Supplier Response Details:
Assessment Last Updated:

Improvement Activity Type:

BI0S Elements | MMOG-LE Subchapters:
Targel Completion Date

Expected Conforming Matenal Date:
Actual Completon Date

First Conforming Material ASN:

Sugplier Improvemant Activity | Reasan for Mo Supplier
Improvement Activity.

Supplier Verification Steps Taken

Approvad:

\erifiad

Assessmant Stalus/Reason;
Agsessment Dedads
Supplier Response Defails:

Assassmant Last Updated

14 /18 T

Description Updated By DateiTime
Tarque/Angle strategy was included as detection contral in PFMEA and Jorge Villanueus 12-Jul-2018 12T PM ET
GP.

TorquedAngle strategy is being included as detection cantral in PFMEA  Jorge Villanueva 25-Jun-2019 1245 PM ET

and CP f===—1]
=——= ———=1==—r0
Description Updated By DateTime
TargquerAngle stralegy was included and evidence is included in Jorge Villapueva 12-Jul-2019 12:11 PM ET
presentation =E==E)
== —=—==a==—a]

clean O G, (N - - . -2015 1012 AM ET
ELI ALBERTO SaucEDo sancHEZ (I - 2019 1 131 AMET

Verified - |mprovement Aclvty and Verification Steps

£l acperTo sauceno savcHEZ, (G - ----2019 1131 AMET

Piwvar

Process Change Goniral

26-Jun-2019

28-Jun-2019

26-Jun-2019

Updated By Date/Time
Jomge Villanueva

Description

Seating focture was adjust 1o comrect posdion and allow 100% verical 12-Jul-2019 1216 PM ET
pasilion, aveiding nsk 10 place sensar in a tited position

Torque controfler arm was installed to fix torque controller device
avolding movenent and providing befier cantral for the operator 1o

exscute the operation,

Seating ficture was adjust to cornect position and allow 100% verdical Jorge Villanueva 26-Jun-2018 12:44 PM ET
position, awsiding nsk 1o place sénsor in a fited pasitan

Tormue coniroller arm was installed to fix lorgue cantrolier device
awoiding movernent and providing bettar cantrol for the oparatar to

execuie the operation.

Updated By DatelTime

Jorge Vilanueva

Description
Focture was adjusied, before and after pictures are included in repod 12 Jul-2078 1216 PM ET

presentaiion
Arm was also installed, asdence 8 also pravded in rapont presentalion

Glern O Grife, (N 7. 2015 112 AM £T
ELl sLeERTE saucEDo sAncHEZ (I - - 2010 1131 AN ET

Werified - iImprovernent Activity and Verification Steps

£u avperTo sauceno sancHEZ (NG 2009 11t AMET

2025 4F 10 A



BHREIL D FEFRR

Imgrovemeant Activity Type: Pritatd

BIOQS Elmmants | MMOG-LE Subchapiers Standardized Work
Target Completan Date: 26-Jun-2018
Expactad Conforming Material Date: 26-Jun-2019
Actual Completian Diate 26-Jun-2018

First Conforming Material ASH:

Suppher improvement Activty / Reasan for No Supplier Description Updated By Date/Time
Improvemant Aty
Operater reinforcemant was done on Jun 14 . 2019 Jorge Villanwava 2B Jun-2016 1240 PMET
per =y
|===—r ==
Dperator rainforcement was done on Jun 14, 2018 Jorge Vislanueva 25-Jun-2018 1238 PM ET
(S
[== e
Supplier Verification Steps Taken Description Updated By DatelTime
Operator reinforcement was varfied on June 14, 2018 Jorge Villanueva M- Jun-2018 1240 PM ET
=
i ===
Approved clenn D Giffe, (I - - 2019 1012 AM ET
Verified EL| ALBERTO saucepo sancHEZ, (I =< !.-2019 1131 AM ET
Assessment Sisus/Reason Venfed - Improvement Actvity and Verification Steps
Assessmend Detads:
Supplier Rasponse Details
Asgessment Lest Updated: EL| ALBERTO saUCEDD sancHEZ, (I -5 2016 11:31 AM ET
Site Read Across Improvement Activities
Improvement Activity Type Site Read Acroes
BIQS Elements: PFMEA
Targat Complaton Dats: 26-Jul-2018
Actual Complation Dale 12-Jul-2018
Supplier improvement Activity / Reason for No Supplier Description Updated By DateTima
Irprovemant Activity
Targue/Angle stralegy deteslion contral n FEMEA and CP Jorge Villanueva 12-Jul-2018 1220 PM ET
o= ———1]
=2 ===
Suppligr Verfication Steps Taken Description Updated By DatelTime
Torque/Angle strategy was included as defection confrol in PFMEA and  Jorge Villanueva 12-Jul2015 1220 PM ET
P, R
Ewvidance is ncluded in report presentaltion _
Verified ELI ALEERTQ SAUCEDD saAncHE: (I 25-ul-2018 11,31 AM ET
Asses=men Status’Reason erified - |mprovement Activity and Verificalion Steps

Assezsment Detads

15/18 I 2025 % 10 H



Supplier Respanse Details:

Assessment Last Updated:

|miprovement Activity Type:
BIQS Eements:

Target Completion Date:
Actual Compietion Data:

Supplier Improvemant Activity / Reason for Mo Suppliar

Improvement Activity,

Supplier Varification Steps Taken:

Verfied

Assassmant Siatus/Reasan
Assessment Detalls
Supplier Responss Details:
Assessment Last Updated:

16/18 U

BHREIL D FEFRR

ELI ALBERTO SAUGEDD SANCGHEZ

Site Read Across

Procass Change Control

12-Jub-2018

12-Juk-2018
Description

Seating fixture was adjustad to correct position and allow 100% vanical
position. avoiding risk to place sansor na lited pasition

Torque contraler arm was installed 1o fix 1omue contraller device
aviiding movemen! and provideg better canteel for the operator (o
execute the operation

Description

Seating fdure was adjusted, before and afler ewidénce was inchided in
repert presertation
Torque contraller arm alss was installed and evidence added 1o report

/ 25 Jud-2018 11:31 AM ET

Updated By

Jarge Villanueva

Updated By

Jerge Vilkanuevs

ELI ALRERTE SAUCEDO sancHEZ (N (5. .-201 1131 AN ET

Verifled - Improvement Activity and Verification Steps

ELl ALBERTC SAUCEDD SanNcHEZ (N : - .i-2079 1131 AM ET

Date/Time
12-Jul-2019 1220 PMET

Date/Time

12-Jul-20192 12:29 PM ET

2025 4F 10 A
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Improvement Activity Type: Site Read Across

BIOS Elements: Standardized Work

Target Completion Date: T Ju-2018

Actugl Completion Date. 14-Jur-2019

Supplier Improvemant Activity | Reasan for No Suppher Description Updated By

Improvemant Activity
¥ Operator reinforcemend was done onJun 14 2018 Jorge Villanueva

Supplier Verification Steps Taken Deseription Updated By

Operator reinforcemant was dane on Jun 14, 2018 Jonge \illanueva

\erified: EL| ALBERTO SAUCEDC SancHEZ, A - - !:-201% 1131 AM ET
Assessment StatusReason: Veribed - Improvament Activity and Vierfication Steps

Assessment Detals,

Supplier Response Details:

Assessment Last Updated: ELl ALBeRTa sauceno sancHEZ (I 001G 11 AMET

Caontrolied Shipping

Customer Assessment:

Created:

Managemen! Confirmation:

Assessment Ressoning

Exit Critena:

Kicko#f Keeting Compéate Date

Cate Ot

Suppleer Contact

Supplhiar Crned:

Contralled Shipping Conforming Material Date
Identification of Certified Material at Supplier Location
Describe Controlied Shipping Actions Taken.

Inspection Service Provider

Customer lssus Owner Change

Customer [asue Owner ctenn 0 Griffin, (N --.un-2015 1018 AMET

Change Safety Decision
Paotential Safely Concern
Last Updated,

Issue Rescinded
Management Confirmation
Ragues! to Rascind:

Reasan for Rescinding |sswe:

Date/Time
12-Jul-2018 1223 PM ET

DatefTime
12-Jul-2019 12:23 PM ET
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SPPSReferencetumber.
PRTS Refergnce Number:

‘No Suppller Response; -

1

18 /18 1

|

2025 &4 10 H



